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1. More Integration 
 

1.1. Sonar Integration with CSH-10 
 

The New 360-degree Omni Scanning Sonar CSH-10 can be 

networked with the NavNet TZtouchXL series MFDs. 

 

On CSH-10 

 Installation setup is required on the CSH-10. 

On NavNet TZtouchXL series MFDs (after setup on CSH-10) 

 Sonar page 

 Overlay on charts 

 Range, Gain, Tilt, Event Mark operation, etc. 

 User menu settings 

See CSH10/TZTXL interface bulletin for details. 

 

 

1.2. Suzuki Engine Display 
 

The NavNet TZtouchXL series MFDs support the Suzuki engine display 

mode, like the Suzuki SMD7/9/12/16 models. With the same 

interconnection and engine configuration as the SM7/9/12/16, the 

TZT10X/13X/16X/22X/24X/BBX can be used as Suzuki engine gauges. 

See Suzuki bulletin for more information. 

 

 

 

1.3. NMEA 2000 Alert PGNs 
 

NMEA 2000 alert PGNs are supported. 

 PGN: 126983 - Alert (Input) 

 PGN: 126984 - Alert Response (Output) 

 PGN: 126985 - Alert Text (Input) 

When third-party devices are connected to the NavNet Command Center via 

HTML, they generate PGNs for alerts. Now NavNet TZtouchXL series MFDs can 

show these alerts on the alarm bar at the top of the screen. Details of each 

alert can be checked on the Alarm List. Alert indications can be turned off in 

[Settings] – [Alarms] – [NMEA 2000 Alert]. 

 

 

CSH-10 – Overview 

 Improved target detection 

 83.5 kHz (±2 kHz selectable) 

 Built-in motion sensor 

 Tilt: －5 to ＋60° 

 400- or 600-mm stroke 

 Faster raise/lower speed: 

7 sec (400 mm) or 10 sec. (600 mm) 

 Max. 20kn (18kn for raise/lower operation) 

 F1 to F10 function keys 

 SXGA (1280×1024) via HDMI 

 Max. range scale 2000 m 

 24 VDC 

https://www.furunousa.com/-/media/sites/furuno/document_library/technical_info/fusa_and_fnd_only_interfacing_and_installation/fusa_only_interfacing_and_installation/navnet_tztouchxl_and_csh10_integration.pdf
https://www.furunousa.com/-/media/sites/furuno/document_library/technical_info/fusa_and_fnd_only_interfacing_and_installation/fusa_only_interfacing_and_installation/navnet_tztouchxl_suzuki_engine_display_mode.pdf
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1.4. NavNet Command Center – New Third-Party Partners 
 

The following third-party partner is added to the network via HTML. Check out the NavNet Command Center bulletin for 

a full listing of HTML5 Third Party Partners.   

 

Company System URL 

VisuWorld Monitoring system VishShip https://visuworld.eu/en/home-en/ 

https://visuworld.eu/en/visuship-en/ 

 

 

2. Refined Visual Impression 
 

2.1. New Startup and Welcome Screens 
 

The background design at startup is refined to have the same deep blue color as the icons and setting pages. Once the 

application starts, the Welcome Screen shows your My TIMEZERO nickname if the display is logged in. In the following 

example, the TZT16X welcomes the user named “Furuno.” 

 

New – V25.11 Previous 

  

  
 

 

 

https://visuworld.eu/en/home-en/
https://visuworld.eu/en/visuship-en/
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2.2. Larger Data Box and Icons 
 

The different size selections in the Scale and Layout menu were reconfigured. All size selections were made larger. This 

change vastly improved the font and object size. The change is most notable on the smaller models such as the 

TZT10X/13X, as shown in the following screenshots. 

 

New – V25.11 Previous 

  
 

2.3. Larger Depth and Temperature Indicators 
 

The default size of the depth indication on Fish Finder, CHIRP Side Scan, and DFF-3D screens is enlarged. In addition, 

the size indication in full-screen mode can be adjusted to much larger sizes: Access [Settings] – [Fish Finder] – [User 

Settings] – [Digital Depth Size] and set [Small] (default), [Medium], or [Large]. The setting in this menu applies to 

the Fish Finder, CHIRP Side Scan, and DFF-3D. [Medium] and [Large] settings apply to full-screen mode only. 

Temperatureindication was also improved. Size was increased and moved to the top of the digital depth display. 

  

  
 

Previous – V24.22 New – Small (Default) 

New – Medium New – Large 

E.g., TZT10X/13X – Double Extra Large (Default) 
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The following screenshots compare the new default [Small] setting with the previous indications. You can see that even 

the small setting offers larger readouts. 

 

Screen New – V25.11 Previous 

Fish Finder 

  

CHIRP Side Scan 

  

DFF-3D 

  
 

 

3. Home 
 

3.1. New Design with Versatile Functionality 
 

 

(1) 

(2) 

(3) 

(4) 

(5) (5) 

(5) 
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(1) The maximum quantity of tiles was increased from 16 to 32. 

(2) A new icon to create a new page is added at the bottom right. 

(3) Edit icons are enlarged. 

(4) The status indicator has additional icons to set each sensor to TX or STBY from Home: Radar, CHIRP Side Scan, 

DFF-3D, NAVpilot, and Sonar. 

(5) New icons for the CSH-10 Omni Sonar, new TZ Weather, and 

SiriusXM™ Weather (North America only). 

   

Note: 

The icon for the video encoder screen is still available. 

  

 

3.2. Assisting to Create Split Screens 
 

For a new page, you no longer need to drag a screen type icon to the page 

builder area, just tap the desired icon. In the example on the right of a 

6-split screen, you may tap each required icon one by one to fill each split 

screen. The page builder will automatically go to and highlight the next box 

to be filled. Note you can still drag an icon to a required screen position.  
 

3.3. Power Off via Home – TZTBBX Only 
 

The TZTBBX can be turned off from the Home page – [Power 

Off] at the bottom left. The TZTBBX can now be turned off via the 

Home page, instead of the ship’s mains. Tip: You can also set in 

the menu, to have the TZTBBX turn on with ship’s mains. 

  

 

3.4. Independent Home Tiles 
 

Home tiles are NOT shared among MFDs in the network. Previously, Home tiles were always shared across the  

Network. Primarily used screen 

modes were sometimes different 

between MFDs (stations). Now, 

Home tiles are set up independently. 

You can use this feature to 

customize/limit the number of home 

screen icons.  
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4. Plotter 
 

4.1. Versatile Slider Bar Options 
 

A range slider bar is added. For more versatile operations, an option to show only the bar without the [+] and [-] range  

buttons is also available. By default, only the range buttons are displayed. For 

standard use, a slider bar can be displayed between the buttons. If only 

dynamic zoom in/out functionality is required, the slider bar can be used 

without the range buttons. These independent settings are available in 

[Settings] – [Chart Plotter] – [Show Range Buttons] and [Show Range  

     

Slider]. 

 
 

4.2. Deep Blue Presentation for Depth 
 

Deep Blue, a new option in Depth Shading, helps to identify areas where the waters suddenly change from shallow to 

deep. In the example below, the area consists of a continental shelf along the coast and a trench in the center. While the 

continental shelf is presented in medium colors, the trench in deeper areas is shown in deep blue color graduations. 

 

New – Deep Blue C.f., Classic Hue (Default) 

  
 

4.3. Adjustable Symbols and Texts on Charts 
 

The size of symbols, chart objects and text on charts can be adjusted in [Settings] – [General] – [This Display] – 

[Plotter Objects Size] – [Small], [Medium], [Large], [Extra Large], or [Double Extra Large]. 
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4.4. Optimized Contextual Menu Orders 
 

The order of setting items in the contextual menu is optimized to show more frequently accessed items on top. 

 

New – V25.11 Previous 

  

 

 

  

Small Medium Large Extra Large Double Extra Large 
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5. Radar 
 

5.1. Versatile Slider Bar Options 
 

A range slider bar is added. For more versatile operations, an option to show only the bar without the [+] and [-] range 

buttons is also available, like in the Plotter. By default, only the range buttons are available. For conventional operation, 

a slider bar may be shown between the buttons. When only dynamic zoom in/out operation is needed, only the slider bar  

without the range buttons may be deployed. These versatile settings are available 

in [Settings] – [Radar] – [User Settings] – [Show Radar Range Button] and  

   

[Show Range 

Slider]. 

 

 
 

5.2. Distance Markers 
 

Distance markers are deployed at 

each range ring, which quickly 

helps identify the distance of 

targets without opening a 

contextual menu. In the following 

example, the Radar range scale is 

set to 4 NM with three rings inside 

and two outside the 4 NM range. 

A total of 6 rings are marked with 

distances. 

  

5.3. Risk Visualizer Icon 
 

While Risk Visualizer mode is turned on, a dedicated 

[RV] icon is displayed on the screen. 
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6. Points and Routes 
 

6.1. Point Filter 
 

Various points entered on the Plotter and Radar can be filtered by icon, color, age, and name. Depending on the 

purposes such, as fishing and navigation, the required points can be displayed. 

 

Plotter and Radar: Access Layer menu – [User Objects] tab – [Point Filters] – [On] and filter by the required options. 

 
 

In the following example, many points are displayed while going to a fishing location. 

 Areas with dangerous underwater structures are marked with the [!] icon. 

 Wrecks are marked with the Wreck icon. 

 Spots where fish were hooked are marked with Fish icons: Single-fish, Double-fish, or Triple-fish. 

 

Plotter – Single-fish icons are filtered to focus on areas where fish were hooked in the past. 
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Radar – When all the points are shown on the screen, echoes can be masked by these points. In this example, [!] icons 

are filtered for caution spots to help recognize the caution areas not identified with Radar echoes. 

 
 

6.2. Shortcut to Points List by Gesture 
Access to the Points List is available with a 

two-finger tap or a two-finger long tap. When 

entered points are frequently reviewed in the 

Points List, quick access to the Points List can 

be assigned in [Settings] – [General] – [This 

Display] – [Two Finger Tap Function] or [Two 

Finger Long Tap Function] – [Points List]. You 

can also set one of the Event Icon 

functions as a shortcut to the Points 

List. 

 

 

6.3. Compass Indicator 
When a route or waypoint is active, a new 

compass bar can be displayed on the Plotter 

and Radar screens. When steering manually, 

the compass indicator, along with the yellow 

deviation marker, helps you track how far 

your ship has strayed from the set course. To 

revert between the two route bar types, just 

tap in the middle of the compass or the route 

bar.  

 

               
 

Also, the data in the Data boxes on each 

end of the compass bar can be 

customized. Just tap in the box to bring 

up available data selections. 
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6.4. Waypoint Centering for Route Creation 
 

When a manual route is created, the chart 

screen can automatically be shifted to show 

a new waypoint in the center of the screen. 

While you make a long route, you no longer 

need to scroll/pan the chart while entering a 

waypoint. 

To activate this function, access [Settings] – 

[Routes] – [Route Settings] and set 

[Intelligent Route Waypoint Centering] 

to [On]. 

 

 
  

Waypoint Centered Not Centered 

  
 

6.5. Navigation Notice for NAVpilot 
 

The description in the message box that appears when activating a route is improved to help users select the most 

appropriate steering option with the NAVpilot-300/711C (Precision or Economy modes) or by hand. 

 

New V25.11 Previous 
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7. Enhanced AI Routing 
 

AI Routing has been improved with the following updates. 

 

Start & End on Land 
 

When a route is created between land areas, AI Routing 

automatically assigns nearby coastal spots on the water as 

start- and endpoints. 

 

Previously, when land areas were selected as start- and/or 

endpoints, AI Routing did not work. 

 

 

 

 

Auto Routing Consistently Available 
 

AI Routing still works while editing a created route. Previously, a 

manual edit of any leg in red was required after automatically 

creating the route with AI Routing. With the new V25.11, the 

route will automatically be adjusted while editing waypoints and 

legs. 

 

Others 
 

(1) Red indications for dangerous or caution areas remain active even after ending route creation. 

(2) Safety depths can be set by selecting from a list in [Settings] – [Routes] – [AI Routing] – [Safety Depth]. Previously, 

entering a specific value was required. Note that the preset value with previous software versions 24.22.2 or earlier 

will not be transferred after updating to V25.11. Make sure to set the safety depth again after the software update. 

(3) A new setting option is added in [Settings] – [Routes] – [AI Routing] – [Strict Depth Compliance] – [ON] or [OFF] 

(default). With this setting turned on, a route will not be created in shallower water than the depth set as safety 

depth. 

(4) Searching time for vector charts and crowdsource recommended routes is improved. 

(5) Waypoints are reduced on vector charts and crowdsource recommended routes. 

(6) The [Safety Distance from Land] setting is removed. 
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8. TZ MAPS 
 

8.1. Dynamic Mooring 
Dynamic Mooring, supported by TZ Navigator, TZ Professional, as well as TZ iBoat, is 

now available on NavNet TZtouchXL series MFDs. Tap the spot where anchoring is 

planned so that the wind forecast is graphically displayed. You can also view previously 

created Dynamic Moorings created by other TZ MAPs community members. 

Note: This function is only available with TZ MAPS – TZ Vector charts. 

 

 

 

 

 

8.2. Enhanced Visibility on Land – Sunlight 
In [Sunlight] presentation mode for TZ MAPS, the visibility of land, such as streets, is improved. 

New – V25.11 Previous 

  
 

8.3. Color Mode Selectable via Layer 
The chart color scheme is selectable on 

the Layer menu. You can switch from one 

to the other depending on the navigation 

purposes, such as fishing or cruising. 

These graphical icons are also available in 

[Settings] - [TZ MAPS]. 

  

8.4. Direct Feedback to Mapmedia 
Feedback on TZ MAPS can be posted directly to Mapmedia via MFDs. 
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9. PBG 
 

The presentation of PBG (bottom mapping) with the DFF-3D is improved as follows. 

 

New – V25.11 Previous 

 Depth contour lines are NOT synchronized with the 

settings on TZ BathyVision.  

 The minimum step is 1 m. The step becomes larger at 

deeper depths. 

 No density level setting is available. 

 Depth contour lines are synchronized with the 

settings on TZ BathyVision. 

 The minimum step is 1 m. 

 To adjust the density level, you need to take multiple 

steps: Switch the chart source to [TZ BathyVision], 

adjust the depth contour level on [TZ BathyVision], go 

back to [TZ Vector] and select [3D Data Source] – 

[DFF-3D] to show PBG. 

 

Notes: 

(1) This presentation is common with the NavNet TZtouch3 series MFDs. 

(2) The edge of the mapping areas is presented with blocks like previous 

software versions, as shown on the right.  
 

 

10. Fish Finder 
 

10.1. New Transducers 
 

Transducer TX 
Power 

Rating 
Frequency Beamwidth Housing Mounting 

ACCU-FISH™ 

Bottom Disc. 

SS175L CHIRP 1 kW 40-60 kHz 32-21° Stainless Thru-hull N/A 

SS175M CHIRP 1 kW 85-135 kHz 16-11° Stainless Thru-hull N/A 

SS175H CHIRP 1 kW 130-210 kHz 10-6° Stainless Thru-hull N/A 

SS175HW CHIRP 1 kW 150-250 kHz 25° Stainless Thru-hull N/A 

M265LH CHIRP 1 kW 
LF: 42-65 kHz 

HF: 130-210 kHz 

LF: 25-16° 

HF: 10-6° 
Plastic In-hull N/A 

M265LM CHIRP 1 kW 
LF: 42-65 kHz 

MF: 85-135 kHz 

LF: 25-16° 

MF: 16-11° 
Plastic In-hull N/A 

M285HW CHIRP 1 kW 150-250 kHz 25° Plastic In-hull N/A 

TM260 CW 1 kW 50/200 kHz 19/6° Urethane Transom Available 
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11. CHIRP Side Scan 
. 

11.1. Auto Gain 
 

Auto Gain now supported for CHIRP 

Side Scan.  

Referring to underwater conditions, 

the gain is automatically adjusted. 

[Gain Mode] can be switched 

between [Manual] and [Auto] in the 

Data Box – CHIRP Side Scan control 

box or the Layer menu. 

 

  

11.2. New Echo Colors 
 

Four (4) new colors are added to support a variety of navigation and fishing scenes. These colors are selectable in the 

Layer menu or [Settings] – [CHIRP Side Scan] – [Echo Color]. 

 

 Tuna Hunter  Aqua Marine  Fury  Volcano 

    
 

11.3. Others 
 

(1) The threshold of Manual Gain is optimized to increase the gain and show echoes in thicker colors. 

(2) The default threshold of the Bottom Level is optimized for more successful bottom detection in deep waters. 
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12. Instrument and Data Box 
 

12.1. Refined Instrument Design 

 
E.g., TZT16X – Instrument Page 

 

New Modern design is added (default). The graphic design is selectable between the new [Modern] and the 

conventional [Legacy] in [Settings] – [Initial Setup] – [Instruments Setup] – [Graphic Instruments Setup] – 

[Instruments Theme]. The screenshots below show the designs on the Instrument page (left) and Data Box (right). 

 

New – Modern Conventional - Legacy 
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New – V25.11 Previous 

  
 

The background color is fixed to Solid Black, and 

the instrument color is fixed to Black. The 

optional Carbon Black background and 

White instruments menu selections are 

removed. 

   

 

12.2. Separator and Spacer 
 

When many graphical instruments and numerical data boxes are deployed on one screen, they can be visually 

categorized into several groups by data type. On the Instrument page, white or red separator lines can be drawn on the 

screen like borders in Excel to recognize the difference in data types. In the Data Box, spacers can be deployed to create 

space between boxes. 

  
 

Instrument with Separators 

 

In the following example, the top area with Highway and Autopilot boxes is assigned to steering aids, the center is for 

engines with numerical data indications, and the bottom shows numerical data for navigation. Two white lines are drawn 

to separate these three data categories. 
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Data Box with Spacers 

 

In the following example, Control Boxes of the Fish Finder and CSH-10 are shown in the same Data Box tab. Three 

spacers in-between help identify the different box types so that users can instantly access the appropriate box. 

 
E.g., - Split Screen with Chart (CSH-10 overlay) and Fish Finder 

 

3×Spacers 

No Spacer 
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12.3. Pinning Favorite Page – Instrument 
 

One of the Instrument pages can be pinned. The Home page shows dedicated tiles depending on the pinned page types: 

[Cruising], [Highway], [Sailing], [Wind], [Tank], [Engine]. Note that pinned pages are NOT synchronized with 

other MFDs in the network. 

 

Pinning Page Examples of Home Tiles 

 

 

 

 

12.4. Others 
(1) Instrument: The Edit menu will not appear with a single tap but now with a long tap only. 

(2) Data Box: The Edit menu will not appear with a long tap. Make sure to tap the [EDIT] icon. 

 

13. TZ Weather 
 

New TZ Weather, available with TZ Navigator, TZ Professional, and TZ iBoat is now available with V25.11. The new TZ 

Weather offers a rich presentation. In addition, a premium weather service is available on a monthly subscription basis. 

 

Sailing 

Tank 

Cruising Highway 

Others 

Engine Wind 
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14. Enhanced Layer Menu 
 

TZtouchXL V25.11 offers more setting options in the Layer menu. 

 

(1) Shortcut icons [ ] to detailed settings are available for certain functions. The following example is the shortcut to 

Points settings.  

 

 

(2) The Layer menu will now open with the previously 

opened tab. It remembers the last menu opened and 

instead of always going to the far-left menu, will now 

go back to the previous menu you had open.  

 

(3) The location of [Community Maps] and 

[ACCU-FISH Icons] are changed to the [Overlays] 

tab.  
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15. Enhanced Search Functions 
 

15.1. Smart Search 
 

Smart Search features available on TZ 

Navigator, TZ Professional, and TZ iBoat, are 

now available with NavNet TZtouchXL series 

MFDs. In addition to chart contents, various 

information such as points, routes, AIS, etc. 

can be searched. The Smart Search page can 

be accessed via Home, the [Search] icon on 

the top left, the Slide-out menu, or a 

two-finger tap. 

 

   
 

15.2. Menu Search 
 

The Settings menu can be searched by text. The 

search box is deployed at the top of the Settings 

page where menu items can be searched. 
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16. Details of Software Versions 
 

The table on the right shows the detailed 

versions of the updated items. 

 

 

Items TZT10X/13X/16X/22X/24X/BBX 

First Boot 1950246-25.11 (Prev. 24.22.2) 

System Version (OS) 1950247-25.11 (Prev. 24.22.2) 

Application 1950248-25.11 (Prev. 24.22.2) 

Built-in Fish Finder: App 0252495-25.11 (Prev. 24.22) 

Selftest Application 1950249-25.11 (Prev. 24.21) 

Browser Files 1950251-25.11 (Prev. 24.21) 

eGuide E42-02205-C (Prev. -B) 
 

17. Others 
 

(1) New: Opened pages or contextual menus can stay on the screen. (Previously, opened pages or contextual menus 

disappeared in preset seconds, the longest being 30 seconds.) 

                 
(2) New: Pinch and pan speed for touch operation can be adjusted 

between [x1] (default) to [x3]. When you frequently scroll and zoom 

in/out charts to check short and long ranges, you may change the 

speed to [x3] to allow charts to be dynamically zoomed and/or 

scrolled.  
(3) New: On the Home page, animation is added when the screen is transferred from Home to the selected page. 

(4) New: TX/STBY buttons for CHIRP Side Scan and Sonar are added in the Quick Access Window. 

(5) Change: The primary source of distance calculation, such as Fuel Distance To Empty (FDTE) and others, is based on 

SOG. (Previous: STW) 

(6) Change: The design of icons at the top of the List page is changed. 

(7) Improvement: When the Fish Finder and CHIRP Side Scan are simultaneously used and either one is set to STBY, 

the other unit still in TX will transmit according to the current range scale. 

(8) Improvement: The issue of no user object synchronization when setting the Anchor Watch Alarm Value in the unit 

of the yard (yd) is fixed. 

--- END --- 

- All brand and product names are registered trademarks, trademarks, or service marks of their respective holders. 

E.g., Contextual menu 

staying on screen Setting: 

[Settings] – [General] – [This Display] – 

[User Interface Auto-Hide], select [Never] 
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